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MEASUREMENT SYSTEM ANALYSIS

(R&R study)
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R&R study

The purpose is to check if the error in measurement system is 

small enough to get reliable data from the process studied.

Variables data

(interval and proportional scale: 0C, kg, N)

Attribute data

(nominal and ordinal scale: good/bad, stage, rank)
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Variables data

bias (accuracy)

precision (R&R)

• repeatability

• reproducibility by different operators

• ratio of precision (measurement error) to the variation

between parts

• estimation of variance components
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Accuracy (bias)

( ) refxxE =

( ) refxxE =:H0

one-sample t test

xref : standard
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H0 (no bias) is accepted at  significance level if 
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i xi refi xx −  

1 5.8 -0.2 

2 5.7 -0.3 

3 5.9 -0.1 

4 5.9 -0.1 

5 6.0 0.0 

6 6.1 0.1 

7 6.0 0.0 

8 6.1 0.0 

9 6.4 0.4 

10 6.3 0.3 

11 6.0 0.0 

12 6.1 0.1 

13 6.2 0.2 

14 5.6 -0.4 

15 6.0 0.0 

 

( ) refxxE =:H0

ns

x
t 0

0

−
=

Xref = 6.0 (standard)

Example 15 (ext.8)

Minitab>Stat>Basic Statistics>1-sample t
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Open Data Table

gagebias.xls

Analyze>Distribution

Y, Column: x

x: Test Mean
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x: Test Mean

Power Animation
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DOE>Sample size and power
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i xi refi xx −

1 5.8 -0.2

2 5.7 -0.3

3 5.9 -0.1

4 5.9 -0.1

5 6.0 0.0

6 6.1 0.1

7 6.0 0.0

8 6.1 0.0

9 6.4 0.4

10 6.3 0.3

11 6.0 0.0

12 6.1 0.1

13 6.2 0.2

14 5.6 -0.4

15 6.0 0.0

Test of means against reference constant (value) (gagebias)

Variable

Mean Std.Dv. N Std.Err. Reference

Constant

t-value df p

x 6.006667 0.212020 15 0.054743 6.000000 0.121781 14 0.904804

( ) refxxE =:H0

ns

x
t 0

0

−
=

xref=6.0 (standard)

Example 15

Statistics>Basic Statistics and Tables>

t-test, single sample
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Splitting the differences into components

Difference between measured values

Differences between parts Differences caused 

by the measurement

Repeatability Reproducibility

Operators Interaction between 

operators and parts
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Total variance of measurement data : 

Fluctuation attributable to the measurement (precision):

Reproducibility:

2

R&R

2

parts

2

total  +=

2

repeat

2

reprod

2

R&R  +=

2

*operpart

2

oper

2

reprod  +=
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Design of experiments for the study

A certain number (e.g. 10) is selected randomly 

from among the parts produced by the process to 

be investigated, all of them measured  several 

(e.g. 3) times by each of the selected operators 

(e.g. 4). 
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operator A B C 

part rept 1 rept 2 rept 3 rept 1 rept 2 rept 3 rept 1 rept 2 rept 3 

1          

2          

3          

4          

5          

6          

7          

8          

9          

10          
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• The variance components are related to the total variance.

• Analogously to the CP process capability index  the ranges

attributed to the variance components is related to the width of

the spec. range (P/T precision to tolerance) . Actually the 99%

(5.15  width) interval is in the numerator:


−


=

LSLUSLT

P R&R
ˆ15.5 

6.0 may stand for  5.15, expressing the  ±3 limit (99.73% 

instead of 99%)

Results:



Six Sigma MSA 136

• The variance components are related to the total variance.

• Analogously to the CP process capability index  the ranges

attributed to the variance components is related to the width of

the spec. range (P/T precision to tolerance) . Actually the 9.73%

(6  width) interval is in the numerator:


−


=

LSLUSLT

P R&R
ˆ6 

5.15 may stand for 6.0, expressing the  99% limit (instead of ±3s 

corresponding to 99.73%)

Results:
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Number of distinguishable categories (discrimination index)

2
ˆ

ˆ

R&R

part




rounded down to integer
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Variance estimation: Range method

Variances are estimated from ranges, e.g.

2

repeat

repeat
ˆ

d

R
=

repeatR

d2 is taken from a Table for the # 

of repetitions

is the average range of repetitions

Similarly for reprod̂ part̂

for small sample sizes different d2 values apply
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Variance estimation: ANOVA method

The model (two-way cross-classification with random 

factors, repeated measurements)

)(ijkijjiijk POOPx  ++++=

P is for parts

O is for operators

 experimental error
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Example 24

The width of the specification for the inner diameter 1.52 mm.

10 parts are taken randomly from the manufacturing, each of 

them are measured 3 times by 2 operators.

Perform a Gauge R&R study!

micro.sta

Statistics>Industrial Statistics & Six Sigma>Process Analysis>

>Gage repeatability and reproducibility
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Repeatability & Reproducibility Summary Plot

No. of Operators: 3 (variable:  operator)

No. of     Parts: 10 (variable:  part)

No. of    Trials: 3 (variable:  trial)
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Plot of Average Measurements by Operator and Part

No. of Operators: 3   (variable: operator)

No. of     Parts: 10  (variable: part)

No. of    Trials: 3   (variable: trial)

 1
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Combined Range Chart

Operators by Parts

Average Range: .045664

Sigma (Range): .023968

No. of Trials: 3

1 2 3

Operators (variable: operator)
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Variance Components; Variable: micro (micro.sta)

Mean=483.535 Std.Dv=.119260

Operators: 3 Parts: 10 Trials: 3

Source

(Expected MS)

Estimatd

Sigma

.90 Lowr

Conf.Lim

.90 Uppr

Conf.Lim

Estimatd

Variance

% of

R & R

% of

Total

Repeatability

Operator

Interaction (OP)

Part-to-Part

Combined R & R

Total

0.026055 0.022695 0.030711 0.000679 6.2345 3.9321

0.085921 0.043097 0.386196 0.007382 67.7951 42.7588

0.053179 0.038615 0.077027 0.002828 25.9704 16.3797

0.079849 0.044634 0.144458 0.006376 36.9294

0.104352 0.075945 0.391256 0.010889 100.0000 63.0706

0.131397 0.017265 100.0000

Percent Tolerance Analysis:micro Sigma intervals:6. (micro.sta)

Mean=483.535 Std.Dv=.119260

Operators: 3 Parts: 10 Trials: 3

Source

(Expected MS)

Measrmnt

Units

.90 Lowr

Conf.Lim

.90 Uppr

Conf.Lim

% Proc.

Variatn

% Total

Contrib.

% of

Tolernce

Repeatability (Equipment Var).

Operator (Appraiser Var.)

Interaction (Operator x Part)

Part Variation

Combined R & R

Total Process Variation

Tolerance

0.156333 0.136172 0.184266 19.8296 3.9321 10.2851

0.515525 0.258584 2.317176 65.3902 42.7588 33.9161

0.319073 0.231688 0.462160 40.4718 16.3797 20.9916

0.479096 0.267801 0.866750 60.7695 36.9294 31.5195

0.626110 0.455672 2.347534 79.4170 63.0706 41.1914

0.788382 100.0000 100.0000 51.8673

1.520000 100.0000
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Example 16

Measure the height of 4 persons by 3 operators with 3 repetitions

operator A B C 

part rept 1 rept 2 rept 3 rept 1 rept 2 rept 3 rept 1 rept 2 rept 3 

1          

2          

3          

4          
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Relating the variance components to the total variance

 

source    2  % in %  in total 

of fluctuation   R&R variation 

(1) repeatability     

(2) operator     

(3) operator*part     

     (2+3) reproducibility     

     (1+2+3) R & R   100  

(4) parts     

       (1+2+3+4) total    100.00 
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Comparisons for the 99% fluctuation range

source of 
99% range of

fluctuation

% in the

total

% in the spec.

fluctuation (515.   ) fluctuation range

repeatability

(gauge)

reproducibility

(operator)

     R & R

parts

     total

fluctuation

100.00

spec. range 100.00

it is not from the summation in the first column! 
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Number of distinguishable categories:

=2
ˆ

ˆ

R&R

part




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Improper measurement system:

X and Moving R Chart; variable:  KERKIVTF

X: 2.1302 (2.1302); Sigma: .03300 (.03300); n: 1.

5 10 15 20 25 30 35 40 45
2.00
2.02
2.04
2.06
2.08
2.10
2.12
2.14
2.16
2.18
2.20
2.22
2.24
2.26

2.0312

2.1302

2.2292

Moving R: .03723 (.03723); Sigma: .02813 (.02813); n: 1.

5 10 15 20 25 30 35 40 45
-0.02

0.00

0.02

0.04

0.06

0.08

0.10

0.12

0.14

0.0000

.03723

.12163
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Attribute gage R&R

The simplest method of study

E.g.  20 „parts” are taken in a random way, all of them is 

checked by at least two operators, at least twice

operator 1 operator 2 reference decision on the 

study 

rept 1 rept 2 rept 1 rept 2   

good good good good good good result 

bad bad bad bad bad good result 

      

good good good good bad bias 

      

good good bad bad  reproducibility! 

      

good bad good good  repeatability! 
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Example 26
(Statistica example)

7 newly hired operators are asked to judge all of 5 parts for 3 trials to 

determine whether a product is considered good or bad, Go (Accept) or 

No-Go (Reject).

MSA_Attribute.sta (File>Open Examples)

Statistics>Industrial Statistics & Six 

Sigma>Process Analysis>

>Attribute agreement analysis

Operator Part Trials Appraisal Standard

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

Karthic 1 1 Go Go

Karthic 2 1 No-Go No-Go

Karthic 3 1 Go No-Go

Karthic 4 1 Go Go

Karthic 5 1 Go Go

Karthic 1 2 Go Go

Karthic 2 2 No-Go No-Go

Karthic 3 2 No-Go No-Go

Karthic 4 2 Go Go

Karthic 5 2 Go Go

Karthic 1 3 Go Go

Karthic 2 3 No-Go No-Go

Karthic 3 3 No-Go No-Go

Karthic 4 3 Go Go

Karthic 5 3 Go Go

Siva 1 1 Go Go

Siva 2 1 Go No-Go

Siva 3 1 No-Go No-Go
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Within Appraisers (MSA_Attribute.sta)

Attribute Agreement Analysis for Appraisal

      

Appraiser # Inspected # Matched Percent 95% Lower CI 95% Upper CI

Jennifer 5 2 40.00 5.27 85.34

Karthic 5 4 80.00 28.36 99.49

Kiron 5 1 20.00 0.51 71.64

Krista 5 4 80.00 28.36 99.49

Nitin 5 4 80.00 28.36 99.49

Sachin 5 5 100.00 54.93 100.00

Siva 5 4 80.00 28.36 99.49

Between Appraisers (MSA_Attribute.sta)

Attribute Agreement Analysis for Appraisal

     

Assessment Agreement

# Inspected # Matched Percent 95% Lower CI 95% Upper CI

5 0. 0.00 0.00 45.07

Each Appraiser vs Standard (MSA_Attribute.sta)

Attribute Agreement Analysis for Appraisal

      

Appraiser # Inspected # Matched Percent 95% Lower CI 95% Upper CI

Jennifer 5 0. 0.00 0.00 45.07

Karthic 5 4 80.00 28.36 99.49

Kiron 5 1 20.00 0.51 71.64

Krista 5 3 60.00 14.66 94.73

Nitin 5 3 60.00 14.66 94.73

Sachin 5 5 100.00 54.93 100.00

Siva 5 3 60.00 14.66 94.73
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Assessment Disagreement (MSA_Attribute.sta)

# Go / No-Go: Assessments across trials = Go / standard = No-Go

# No-Go / Go: Assessments across trials = No-Go / standard = Go

Appraiser # Go / No-Go Percent # No-Go / Go Percent # Mixed Percent

Jennifer 0 0.00 2 66.67 3 60.00

Karthic 0 0.00 0 0.00 1 20.00

Kiron 0 0.00 0 0.00 4 80.00

Krista 1 50.00 0 0.00 1 20.00

Nitin 0 0.00 1 33.33 1 20.00

Sachin 0 0.00 0 0.00 0 0.00

Siva 1 50.00 0 0.00 1 20.00

All Appraisers vs Standard (MSA_Attribute.sta)

Attribute Agreement Analysis for Appraisal

     

# Inspected # Matched Percent 95% Lower CI 95% Upper CI

5 0. 0.00 0.00 45.07
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Assessment Agreement

Within Appraisers

 95% CL

 Percent

Jennifer Karthic Kiron Krista Nitin Sachin Siva
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 Percent

Jennifer Karthic Kiron Krista Nitin Sachin Siva

Appraiser

0
10
20
30
40
50
60
70
80
90

100

P
e

rc
e

n
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Statistics>Industrial Statistics & Six Sigma>Process Analysis>

>MSA Attribute Data



Six Sigma MSA 158

Attribute MSA Analysis (MSA_Attribute.sta)

Number and Type Mistake By Operator

Truth Jennifer Karthic Kiron Krista Nitin Sachin Siva Total

False rejects

False accepts

Number of correct decisions

Total opportunities for a decision

Total opportunities to rate good parts

Total opportunities to rate bad parts

Go 7 0 3 0 3 0 1 14

No-Go 2 1 2 4 1 0 3 13

6 14 10 11 11 15 11 78

15 15 15 15 15 15 15 105

9 9 9 9 9 9 9 63

6 6 6 6 6 6 6 42

Attribute MSA Analysis (MSA_Attribute.sta)

Inspection Capability

Jennifer Karthic Kiron Krista Nitin Sachin Siva Total

Effectiveness

P(FR)

P(FA)

Bias

Unacceptable Acceptable Unacceptable Unacceptable Unacceptable Acceptable Unacceptable Unacceptable

Unacceptable Acceptable Unacceptable Acceptable Unacceptable Acceptable Unacceptable Unacceptable

Unacceptable Unacceptable Unacceptable Unacceptable Unacceptable Acceptable Unacceptable Unacceptable

Unacceptable Unacceptable Acceptable Unacceptable Unacceptable Unacceptable Marginal

Attribute MSA Analysis (MSA_Attribute.sta)

Inspection Capability

Jennifer Karthic Kiron Krista Nitin Sachin Siva Total

Effectiveness

P(FR)

P(FA)

Bias

0.40000 0.93333 0.66667 0.73333 0.73333 1.00000 0.73333 0.74286

0.77778 0.00000 0.33333 0.00000 0.33333 0.00000 0.11111 0.22222

0.33333 0.16667 0.33333 0.66667 0.16667 0.00000 0.50000 0.30952

2.33333 0.00000 1.00000 0.00000 2.00000 0.22222 0.71795
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Example 55

5 operators assess twice the quality of a product

attrib.mtw 

Stat>Quality Tools>Attribute Agreement Analysis
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54321
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95.0% C I
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Date of study:                         

Reported by:                         

Name of product:                         

Misc:                         

Assessment Agreement

Within Appraisers Appraiser vs Standard
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Example 27

All participants assess twice if print on M&M candies is OK or not
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depends on data (process)
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